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Preface

All ASM products and the Email Archive Manager (EAM) use one central 
License Server to manage licensing information. The License Server is the 
computer on which the License Server software and subsequently the 
licenses for your ASM products are loaded.

The License Server Administrator allows you to perform each of the following 
administrative functions:

• Register license files or license keys for ASM  products

• Create groups for licenses allowing for subdivision of licensing access

• View information relating to the License Server installation

• Configure alerts for the License Server computer

• Use troubleshooting functions such as logs and event viewing

• Generate and configure License Server reports

• Use the Repair Disk function to back up and restore the License Server 
configuration

■ Chapter Summary
The following table summarizes each chapter of this document:

Table 1.  Chapter Summary

Chapter Description
Chapter 1: Installing 
License Server on page 1 

This chapter contains instructions for installing 
License Server software.

Chapter 2: Working in the 
Administrator on page 9 

This chapter describes the Administrator 
interface and basic functionality.

Chapter 3: Configuring 
and Managing Product 
Licenses on page 17 

This chapter describes how to register license 
files or license keys and how to interpret the 
license information that the Administrator 
displays.

Chapter 4: Configuring 
and Managing License 
Groups on page 29 

This chapter describes how to create and 
manage license groups for subdividing license 
access.
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■ Online Help
Help is available online and provides descriptions of concepts, detailed 
instructions, and reference material to help you use License Server.

To access online help from the Administrator:

• You have the following choices:

• From the Administrator's Help menu, select Contents. A Help window 
appears.

• For a description of any License Server dialog box, display the dialog 
box and press <F1> or click Help. A Help window appears, outlining 
the dialog box parameters and fields.

To access online help from the Start menu:

1. From the Windows Start menu, select Programs and then  Legato License 
Server.

2. From the Legato License Server menu, select Help and then Online 
Reference.

Chapter 5: Managing the 
License Server Computer 
on page 39 

This chapter describes how to view information 
relating to the License Server installation. This 
chapter also describes how to configure alerts 
for the License Server computer, as well as 
troubleshooting functions such as logs and 
event viewing. 

Chapter 6: Running 
License Server Reports 
on page 53 

This chapter describes how to generate and 
configure License Server reports.

Chapter 7: License Server 
Backup and Recovery on 
page 65 

This chapter describes how to use the Repair 
Disk function to back up and restore the 
License Server configuration.

Chapter 8: Remotely 
Administering License 
Server on page 73 

This chapter describes how to administer the 
License Server system from remote computers.

“Using RtfPad” on 
page 85

This appendix describes how to use the RtfPad 
application to save, print, and email reports, 
event logs, and Event Viewer snapshots.

“Uninstalling License 
Server Components” on 
page 91

This appendix describes how to uninstall 
License Server software.

Table 1.  Chapter Summary

Chapter Description
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■ Documentation Conventions
Consistent formatting is used throughout this guide to represent certain 
information.

Table 2.  Documentation Conventions

This Cue Represents
monospaced text Characters that must be typed on your screen 

exactly as they appear in this document.

<ALL CAPITALS> Keys on your keyboard used in combination or 
sequence. For example <ALT>+B means to 
hold down the <ALT> key while pressing B, and 
<ALT>, F, X means to press and release each 
of the keys in order: first <ALT>, then F, then X.

ALL CAPITALS Directory names, filenames, and acronyms.

italics References to manual titles, chapter titles, and 
section headings; placeholders; and emphasis.

Note 
Explanatory note between 
two lines. 

Additional information needed as you follow the 
step-by-step operations in this manual.
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1Installing License Server

License Server is installed using the License Server Setup Wizard. See the 
following sections for more information about installing License Server:

• "Before Running the Setup Wizard, " which follows

• “Running the License Server Setup Wizard” on page 4

■ Before Running the Setup Wizard
When you purchase any ASM product or Email Archive Manager (EAM), you 
receive one or more licenses for that product. License Server has an 
administrative interface that allows you to manage licenses for all of your ASM  
products and EAM from one central location. The following procedure 
provides an overview for this chapter:

To install License Server:

1. Make sure that the computer on which you intend to install License Server 
meets the requirements for License Server. For information, see 
“Specifications and Requirements” on page 2. 

Note: If you are upgrading to a service release of License Server on 
Microsoft® Windows® 98, see “Upgrading on Windows 98” on 
page 4.

2. If you are installing License Server on multiple computers, review the 
information in “Multiple License Server Configurations” on page 2.

3. If you are running Windows NT or Windows 2000 as the operating system 
on the computer on which you intend to install License Server, create a 
service account for the License Server service to use. For instructions, see 
“Creating a Service Account” on page 3. 

If you are installing License Server in a Microsoft Active Directory® service 
environment, be advised that Data Manager supports a limited number of 
configurations. For more information, refer to the ASM Knowledge Base.

4. If you are installing License Server in a clustered environment, review the 
information in “Clustering” on page 3.

5. Use the License Server Setup Wizard to install License Server and, if 
necessary, to upgrade existing license information. For instructions, see 
“Running the License Server Setup Wizard” on page 4.
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On Windows 98, License Server is installed as an application running on 
the Taskbar. On Windows NT and Windows 2000, License Server is 
installed as a service. 

Note: You cannot upgrade evaluation license information.

6. If you intend to access and administer License Server from another 
computer (that will not have a full installation of License Server), you need 
to install the Remote Administrator on that computer. 

After installing the Remote Administrator on the remote computer, you can 
use it to access License Server. For information on using the Administrator 
to access License Server remotely, see the “Remotely Administering 
License Server” on page 73.

Specifications and Requirements
When designating a computer for License Server, make sure that all ASM 
product users have access to that computer. The minimum requirements for 
License Server are listed in the following table:

Multiple License Server Configurations
Very few ASM product users need multiple License Server computers. Those 
who do are typically in one of the following situations:

• ASM products are implemented in secure systems in which the use of a 
single License Server would require connections across a firewall.

• ASM products are implemented across multiple departments, each of 
which need to perform licensing independently of the others. For example, 
the sales and accounting departments of a company may be budgeting for 
ASM products separately.

In either of these cases, if the License Server computers are visible on the 
network, you can use the Administrator to access and administer them, 
whether the Administrator was installed as a Remote Administrator or as a full 

Table 3.  Minimum Server Requirements

Requirement Details
Processor Pentium PC (A faster processor increases License 

Server productivity.)

Available hard 
disk space

29 MB

Memory 64 MB of RAM

Operating 
System

Windows 95 (OSR 2), Windows 98, Windows NT 4.0 
(Service Pack 6a), Windows 2000 (Service Pack 2 or 
higher), or Windows XP
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installation of Legato License Server. Keep in mind that in order to view the 
licensing information that has been registered on a particular License Server 
computer, you must register and connect to that computer through the 
Administrator. For instructions, see “Registering a Computer for Remote 
Administration” on page 78.

When the Administrator is opened, it attempts to connect to all registered 
License Server computers (including the local computer for full installations of 
License Server). Once these connections have been made, the window 
displays information pertaining to each License Server service. The 
Administrator allows you to switch easily between registered computers by 
selecting the computers in the tree view or from the Computer drop-down list.

Creating a Service Account
If you are installing License Server on a computer running Windows NT or 
Windows 2000 as its operating system and you do not already have a service 
account that you would like License Server to use to log on as a service, you 
should create the service account before installing License Server. 

The account should be a local administrator on the machine on which you are 
installing License Server. You should log on using this service account when 
running the setup wizard so that you can specify the account as required.

Clustering
Clustering is the process of connecting two or more computers together in 
such a way that they behave like a single computer, and so that they share a 
single storage device. 

In a cluster configuration, each computer automatically updates the other 
computer with registry information so it can intervene when needed. If one of 
the servers stops functioning, the other server assumes the workload of the 
failed server. The act of transferring functions to another server in the cluster 
is called fail-over. Fail-over ensures continuous availability of critical 
applications and data located on the cluster. 

The server computers that are part of the cluster are called nodes or systems, 
and can be either active or passive. An active node is always running and 
processing user requests. A passive node, however, is idle and does not 
process user requests until an active node fails. 

Applications can run in either active/active or active/passive mode in a cluster. 

• In an active/passive configuration, applications and services running on 
the active node transfer over to the passive node when the active node 
fails. The active node is also called the primary node, while the passive 
node is called the secondary node.
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• In an active/active configuration, applications and services can be running 
on both of the active nodes and transfer over to one node if the other fails. 
The applications and services that were originally running on the failed 
node are then restored to the node when it comes back online.

License Server 5.2 or higher can run in active/passive mode in a cluster where 
Microsoft’s Cluster Administrator is installed. In an active/passive cluster, 
License Server runs as a single service on the active, or primary, node. When 
the primary node fails, the service is transferred to the secondary node, which 
is then considered the primary node because it becomes active. All License 
Server functionality is available on the primary node and completely transfers 
in the case of a fail-over.

ASM Data Manager 5.3 or higher, licensed through License Server, can run in 
active/active mode in a cluster where Microsoft’s Cluster Administrator is 
installed; however, License Server itself can run only in an active/passive 
cluster mode. 

Note: Although Legato License Server can run in active/passive mode in a 
cluster, only licenses for ASM Data Manager and ASM MediaStor are 
cluster-enabled; you should only install Legato License Server on a 
cluster if you are licensing those products. If you are installing other 
ASM products, do not install Legato License Server on the cluster.

For detailed information on installing and configuring License Server in a 
clustered environment, refer to the Clustering appendix of the ASM Data 
Manager Getting Started Guide.

Upgrading on Windows 98
If you are upgrading to a service release of License Server on Windows 98, 
you must do each of the following:

• Before running the License Server Setup Wizard, you must exit from the 
Administrator and manually stop the service. To manually stop the service, 
press <CTRL>+<ALT>+<DELETE>, click on Task Manager, then select 
Lsservice from the Close Programs dialog box, and click End Task.

• After running the License Server Setup Wizard, you must manually restart 
the service. To manually restart the service, navigate to C:\PROGRAM 
FILES\LEGATO\LICENSE SERVER\BIN and run LSSERVICE.EXE.

■ Running the License Server Setup Wizard
The License Server Setup Wizard leads you through the necessary steps for 
installing License Server. 
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Note: The service account used to install License Server must be a member 
of the local Administrators group on the computer where the 
installation is performed.  

To install License Server:

1. Exit all applications on the computer on which you want to install License 
Server. The License Server Setup Wizard may not be able to write to all 
necessary files if other software is running.

2. Insert any ASM setup CD-ROM into the drive. 

3. From the Windows Start menu on the computer on which you want to 
install License Server, select Run. 

Note: If you are installing License Server on a clustered environment, 
you must install the License Server program on the primary node 
(the server node currently in control). The install program will fail if 
initiated on a machine other than the primary node of the cluster.

Note: If you are installing License Server on a NAS device as part of an 
ASM system, insert the setup CD-ROM into a CD-ROM drive to 
which you can browse on the network. Then, open a Terminal 
Services session for the device. Then, from the Windows Start 
menu for the device, select Run.

4. The Run dialog box appears. 

5. In the Open text box, click Browse to browse to the location of the setup 
files. 

6. Click OK. The License Server Setup Wizard is initiated (which may take up 
to two minutes), and the setup wizard appears, starting with a welcome 
page. The License Server Setup welcome page briefly describes the 
installation process.

7. Click Next. The Installation Options page appears.

Figure 1.  License Server Setup Wizard - Installation Options Page 

8. Select the Install new product option and then click Next. The License 
Agreement page appears. 
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Figure 2.  License Server Setup Wizard - License Agreement Page 

9. You must accept the terms of the license agreement before you can 
proceed with the installation. Enable the check box next to Accept terms of 
agreement to agree to the terms of the agreement and then click Next. The 
Registration page appears.

Figure 3.  License Server Setup Wizard - Registration Page 

10. In the Customer Name text box, type the customer name. 

11. In the Organization text box, type the organization name. 

12. Click Next. The Service Account page appears.

Figure 4.  License Server Setup Wizard - Service Account Page 

13. Under Service Account Information, enter information for the account that 
you want to use as the License Server service account. Make sure this 
account has access to the network and is an administrator on the local 
domain.
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14. Click Next. The Summary page appears. This page shows the customer 
name and organization and displays the name of the target computer (the 
computer on which the setup wizard is installing License Server).

15. Verify the accuracy of the information. If all information is correct, click 
Finish. The License Server Setup Wizard copies all program files onto the 
system, and adds License Server entries and the program folders to the 
system configuration for the target computer. A progress bar displays the 
status of the operation.

Note: If necessary, you can click Cancel at any time to abort the setup 
process.

If the installation is successful, a window appears asking if you would like 
to start the Administrator. 

Figure 5.  Setup Complete Message 

16. You have the following choices:

• Click Start to close the setup wizard and open the Administrator.

• Click Exit to close the setup wizard without starting the Administrator.

Once License Server is installed, you can begin registering your ASM 
licenses. For instructions on registering your licenses, see “Configuring 
and Managing Product Licenses” on page 17.
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2Working in the Administrator

Because License Server is a Windows-based package, the same easy, 
intuitive navigational standards apply to all of its components. The 
Administrator provides a user-friendly interface that allows you to easily 
manage product licensing.

The Administrator has an intuitive “tree” view that displays the underlying 
structure of the License Server system. The tree structure contains two nodes: 
Licenses and Groups. Each ASM product (when license information for it has 
been registered) appears as a node under the License node. Each configured 
license group appears as a node under the Groups node.

The Administrator can be run on the same computer where License Server is 
installed or from a remote workstation using the Remote Administrator. For 
more information on remote administration, see “Remotely Administering 
License Server” on page 73.

The following sections explain the basic layout of the Administrator, as well as 
its general functionality. Included are explanations of window features and 
methods for carrying out system operations.

• "Starting the Administrator, " which follows

• “The Administrator Window” on page 10

• “Refreshing the Administrator Window” on page 14

• “Searching in the Administrator” on page 15

■ Starting the Administrator
Starting the Administrator allows you to access product licensing information. 
You can connect to the local or remote License Server computer through the 
Administrator interface and configure licensing information on that computer. 

Upon successful connection to a License Server computer, the Administrator 
appears with all licensed ASM products displayed in a tree-like structure. The 
tree structure contains two nodes for each connected computer: a License 
node and a Groups node. 

To open the Administrator:

• From the Windows Start menu, select Programs,  License Server, and 
then Administrator. The Administrator window appears.
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Figure 6.  License Server Administrator 

When the Administrator opens, it automatically connects to all registered 
License Server computers. If this is a full installation of License Server (as 
opposed to a Remote Administrator installation), the local computer is 
automatically registered, and therefore automatically appears in the 
Administrator.

In addition, if you installed License Server on multiple target computers, 
License Server automatically registers and attempts to connect to all target 
computers identified during License Server install. Once these connections 
have been made, the Administrator displays information relevant to each 
connected License Server computer.

If you want to administer License Server on computer(s) other than those 
currently connected, you must register the License Server computers through 
the Administrator. For more information, see “Registering a Computer for 
Remote Administration” on page 78.

■ The Administrator Window
The main portion of the Administrator window is for navigation and information 
display, and is split into three panes:

• The left pane of the window, or the tree view, contains the tree-like 
structure from which most commands are performed. For more 
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information, see "The Tree View: Exploring License Server, " which 
follows. 

• The top right pane, or the contents view, displays the contents of the item 
currently selected in the tree. For more information, see “The Contents 
View: Node Details” on page 12.

• The bottom right pane, or the description view, displays a description or 
detailed properties of the item selected. For more information, see “The 
Description View: Item Details” on page 12.

Split bars separate the panes of the Administrator window. These split bars 
can be moved to change the size of each pane.

To move the split bar:

• Drag the bar to its new location.

The Administrator window also contains several additional components that 
allow you to navigate through and configure License Server:

• The menu bar contains the menu commands and can be found at the top 
of the window. For more information, see “Menu Bar” on page 12. 

• The Computer drop-down list, which allows you to switch between 
registered License Server computers, can be found just below the menu 
bar on the left. For more information, see “Computer Drop-Down List” on 
page 12.

• The toolbar, containing buttons that allow you to perform frequently used 
functions, can be found just below the menu bar to the right of the 
Computer drop-down list. For more information, see “Toolbar” on page 13.

• The status bar, which displays information about the selected command or 
toolbar button, can be found at the bottom of the window. For more 
information, see “Status Bar” on page 14.

The Tree View: Exploring License Server
The left pane of the Administrator window contains a tree showing all 
connected License Server computers, and all product licenses and license 
groups configured for each License Server computer. 

Each node in the tree indicates whether it is expandable; that is, whether it 
contains items beneath it. A plus sign (+) marks a node that is expandable. 
When a node has been expanded, the plus sign changes to a minus sign (-), 
indicating that it has been expanded and can now be collapsed. 

To expand a node:

• Click the plus sign to the left of the node, or double-click the item.
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To collapse a node:

• Click the minus sign to the left of the node, double-click the item.

If a node appears with neither sign, that means it currently contains no items 
within it. For example, if the Groups node does not have a plus (+) or minus (-
) sign in front of it, there are no license groups available.

The Contents View: Node Details
The top right pane of the Administrator window contains the contents of the 
node currently selected in the tree on the left. These contents include the 
same information displayed underneath the node in the tree when the node is 
expanded. For example, selecting the Licenses node lists all product licenses 
in the contents view. The same information is listed underneath the Licenses 
node when that node is expanded. You can select an item either in the tree 
view or in this contents view to make the appropriate commands available. 

The Description View: Item Details
The bottom right pane of the Administrator window contains details of the item 
currently selected in the tree on the left. This section displays licensing and 
group information about the currently selected product license. 

Menu Bar
The menu bar contains a list of menus with commands for carrying out 
functions in the Administrator. Although many functions can easily be 
performed using shortcut menus or toolbar buttons, all functions can be 
performed through the menu commands as well. When you select a node in 
the tree view, the Edit menu changes to contain the same commands 
available on the shortcut menu for that node.

Computer Drop-Down List
The Computer drop-down list displays the name of the currently active 
computer. You can activate a different License Server computer in the 
Administrator by either selecting the computer from the Computer drop-down 
list or highlighting the computer in the tree view of the Administrator.

In order for a computer to appear in the Computer drop-down list, the 
computer must be registered through the Administrator. For information on 
registering License Server computers to add them to this list, see “Registering 
a Computer for Remote Administration” on page 78.
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Toolbar
The License Server toolbar is located directly beneath the menu bar, to the 
right of the Computer drop-down list. The toolbar contains buttons that provide 
quick access to many of the Administrator commands and features. 

To identify the function of a button, point to the button with the mouse. The 
button’s function appears in the status bar at the bottom of the window, and as 
a pop-up tool-tip when the mouse is held over the button.

The toolbar button is grayed out if it is not available for the item you have 
selected in the Administrator. 

To show or hide the toolbar:

• From the View menu, select Toolbar. A check mark beside the command 
indicates that the toolbar is displayed.

Figure 7.  License Server Administrator Toolbar 

Table 4.  License Server Administrator Toolbar Buttons

Button Name Menu Option Function
Connect to 
Service

From the Service 
menu, select 
Connect.

Connects to the selected 
License Server computer. 
For more information, see 
“Connecting to License 
Server Computers” on 
page 83.

Disconnect 
from Service

From the Service 
menu, select 
Disconnect.

Disconnects from the 
currently active License 
Server computer. For more 
information, see 
“Disconnecting from a 
License Server Computer” 
on page 83.
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Status Bar
The status bar is located at the bottom of the Administrator window and 
displays information about the selected command or toolbar button. 
Translations of certain commands or important messages to the user appear 
on the status bar.

To show or hide the status bar:

• From the View menu, select Status Bar. A check mark beside the 
command indicates that the status bar is displayed.

■ Refreshing the Administrator Window
Refreshing updates the contents of and repaints everything in the 
Administrator window. The Administrator window is refreshed when each of 
the following occurs: 

• A command is performed. 

• A node in the tree is expanded or collapsed. 

• You press <F5> or select Refresh from the Tree menu. (This is considered 
a forced refresh.)

• The time specified for automatic refresh frequency has expired.

Configuring Auto Refresh Frequency
You can configure the frequency of the automatic refresh of the Administrator 
window. The default refresh rate is 5 seconds. 

Register 
Computer

From the Service 
menu, select 
Register. 

Displays the Register 
Computers dialog box, 
which allows you to register 
remote License Server 
computers. For more 
information, see 
“Registering a Computer for 
Remote Administration” on 
page 78.

Properties From the Edit 
menu, select 
Properties.

Displays the Properties 
dialog box for the selected 
object.

Table 4.  License Server Administrator Toolbar Buttons

Button Name Menu Option Function



Searching in the Administrator

ASM License Server System Guide 15
StorageTek Proprietary

To enable or disable auto refresh:

• From the Tree menu, select Auto Refresh. 

To change the auto refresh frequency:

1. From the Tree menu, select Auto Refresh Frequency. The Auto Refresh 
Frequency dialog box appears.

Figure 8.  Auto Refresh Frequency Dialog Box 

2. In the Frequency text box, enter the appropriate number of seconds 
between refreshes and then click OK.

■ Searching in the Administrator 
As multiple licenses, license groups, and computers (for remote 
administration) are added to the system, the tree view may become so large 
as to become difficult to locate a specific node of the tree. The Find command 
in the Tree menu can be used to quickly locate occurrences of text within the 
tree. This can be especially useful for finding a specific license or group.

The Administrator searches from the currently highlighted position in the tree 
to either the end or to the beginning of the tree, depending on the direction you 
choose. To search the entire tree, select an item either at the top or bottom of 
the tree before beginning the search and select the Up or Down direction as 
appropriate.

To search for specific text in the tree:

1. From the Tree menu, select Find. The Find dialog box appears. 

Figure 9.  Find Dialog Box 

2. In the Find what text box, type the text you want to find. 

3. Select the direction in which you want License Server to perform the 
search. You have the following choices:

• Enable the Up option to search up in the tree from the currently 
highlighted position.
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• Enable the Down option to search down in the tree from the currently 
highlighted position. This option is enabled by default.

4. Choose whether you want License Server to match the case of the 
selected text. You have the following choices:

• Enable the Match case check box to find only words having a certain 
pattern of uppercase and lowercase letters. For example, select this 
option to find “LICENSE” but not “license.”

• Disable the Match case check box to find all words matching the 
entered text, regardless of case. This option is disabled by default.

5. Click Find Next. The first occurrence of the text is highlighted in the tree. 

6. If the tree is not visible, move the Find dialog box by dragging its title bar.

7. To find the next occurrence, click Find Next again. 

8. When you find the text you are looking for, click Cancel to close the Find 
dialog box.

Note: After you close the Find dialog box, you can select Find Next from the 
Tree menu (or press F3) to find the next occurrence of the most 
recently specified text.
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3Configuring and Managing 
Product Licenses

Licensing for ASM and Email products, including Email Archive Manager 
(EAM), Email Content Manager (ECM), and Email Regulatory Manager 
(ERM), uses a license key (or text key) that you enter through License Server 
to activate licensed use of the product. Encoded in this key are limits for all 
features within a specific product (for example, maximum number of users on 
an storage device type for an ASM system).

The following sections discuss how to register your license information in 
License Server. In addition, License Server contains a user management 
utility that allows you to view and, if necessary, log off connected users. 

• "Obtaining Your Machine ID, " which follows describes how to find your 
License Server computer machine ID, which you need to supply to your 
technical support representative in order to generate a product license.

• “Registering License Information” on page 18 describes how to register 
license information from either a license file or a license key.

• “Viewing License Information” on page 22 describes how to view the 
properties information for registered licenses.

• “Monitoring License Usage” on page 26 describes how to monitor the 
usage of all licensed products.

For information on subdividing licenses among groups, see “Configuring and 
Managing License Groups” on page 29.

■ Obtaining Your Machine ID
Licenses for ASM products are obtained through your technical support 
representative. In order to generate a product license, however, you need to 
supply the machine ID for the computer on which License Server is installed. 
Machine IDs are unique to each computer and consist of a series of numbers 
and/or letters.

To obtain your machine ID number:

• From the Service menu in the Administrator, select Properties. The 
machine ID appears on the General tab of the Service Properties dialog 
box.
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Figure 10.  Service Properties Dialog Box – General Tab 

■ Registering License Information
Product licenses are provided in the form of either a license key or a license 
file. A license key is a series of numbers and letters that encode the specific 
product information and rights you purchased for your  product. A license file, 
which has an .LIC file extension, is simply a text file that contains that license 
key.

The New License Wizard allows you to register your license information using 
either a license key or a license file. You must use the New License Wizard to 
register license information in both of the following scenarios:

• You have an upgrade license for a product that is already licensed.

• You have a license for a product that has not been licensed before.

For more information, see the following sections:

• "Registering a License File, " which follows

• “Registering a License Key” on page 20 

Registering a License File
If you receive your ASM product license information in the form of a file with an 
.LIC extension, you have a license file. A license file is nothing more than a 
basic text file that contains your product license key. 

The New License Wizard allows you to register your license by browsing to 
the *.LIC file. The wizard then reads the license key information from the file 
and registers the license and its associated information. 
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To register a license file:

1. From the Tools menu in the Administrator, select New License Wizard, or 
press <CTRL>+L. The New License Wizard appears, starting with the 
License Type page.

Figure 11.  New License Wizard – License Type Page 

2. Select Read license information from LIC file and click Next. The Select 
File Location page appears.

Figure 12.  New License Wizard – Select File Location Page 

3. In the Location text box, enter the path and file name of the license file in 
the Location text box, or click Browse to browse to the license file. 

4. When the path and file name of the license file appear in the Location text 
box, click Next. The License Details page appears, displaying the license 
information encoded in the license file.
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Figure 13.  New License Wizard – License Details Page 

For details on the information displayed for each product license, see the 
specific product sections within “Viewing License Information” on page 22.

5. Click Next. The summary page appears, summarizing what actions the 
wizard is configured to perform.

6. Click Finish. The license is added to License Server.

Registering a License Key
If you receive your ASM product license information in the form of a series of 
numbers and letters, you have a license key. A license key is nothing more 
than a series of letters and numbers that encodes the information that License 
Server needs to license your ASM product with the specifications you 
purchased. 

The New License Wizard allows you to register your license by copying and 
pasting that series of letters and numbers into the wizard. The wizard then 
interprets the license key information and registers the license. 
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To register a license key:

1. From the Tools menu in the Administrator, select New License Wizard, or 
press <CTRL>+L. The New License Wizard appears, starting with the 
License Type page.

Figure 14.  New License Wizard – License Type Page 

2. Select Enter license key manually and click Next. The Enter Key page 
appears.

Figure 15.  New License Wizard – Enter Key Page 

3. In the Key text box, enter the license key. You may type the information or 
copy it from another file and paste it into the Key text box. 

4. When the license key information appears in the Key text box, click Next. 
The License Details page appears, displaying the license information 
encoded in the license key.
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Figure 16.  New License Wizard – License Details Page 

For details on the information displayed for each product license, see the 
specific product sections within “Viewing License Information” on page 22.

5. Click Next. The Summary page appears, summarizing what actions the 
wizard is configured to perform.

6. Click Finish. The license is added to License Server.

■ Viewing License Information
After you have registered a license, you can use the Properties dialog box to 
view detailed information about the license, license group, and configuration 
information for that product.

To display license properties for a product:

• Double-click the product license for which you want to display information, 
or right-click the license and then select Properties from the shortcut 
menu.
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Figure 17.  License Properties Dialog Box 

The License Properties dialog box has a single General tab. This tab lists all 
available license types configured to the product license, and the total number 
of connections allowed by each of the license types. 

If grouping is available for the license, the tab also shows to what groups (if 
any) license types have been assigned. Any license type connections not 
assigned to a license group appear in the [DEFAULT] group. For more 
information on license groups, see “Configuring and Managing License 
Groups” on page 29.
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In addition, the License Properties dialog box shows you how many of each of 
the license types is currently being used.

Note that different license information appears for each product. For more 
information, see the following sections:

• “ASM License Information” on page 24

• “Configuring and Managing Product Licenses” on page 17

• “Email Archive Manager License Information” on page 25

• “Email Content Manager License Information” on page 25

• “Email Regulatory Manager License Information” on page 26

ASM License Information
The following table describes each of the items that the License Server 
Administrator may display for an ASM license:

Table 5.  ASM License Information

Attribute Name Description
MediaStor Lists the storage devices for which you are 

licensed by type, quantity, and level.

EMC Capacity Maximum amount of space that can be used in 
EMC Centera Content Network Repository 
storage devices.

ACSLS Servers Maximum number of Automated Changer 
Storage Library System (ACSLS) servers to 
which data can be saved. ACSLS is a product 
of StorageTek.

ACSLS Capacity Maximum amount of space that can be used in 
ACSLS servers.

TSM Servers Maximum number of Tivoli Storage Manager 
(TSM) servers to which data can be saved. 
TSM is a product of Tivoli.

TSM Capacity Maximum amount of space that can be used in 
TSM servers.

RAID/NAS Capacity Maximum amount of space that can be used in 
network attached storage (NAS) servers.
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Email Archive Manager License Information
The following table describes each of the items that the License Server 
Administrator may display for a Email Archive Manager (EAM) license:

Email Content Manager License Information
The following table describes each of the items that the License Server 
Administrator may display for an Email Content Manager  (ECM) license:

Table 6.  EAM License Information

Attribute Name Description
Mailboxes Maximum number of mail users for which your mail 

server(s) are licensed.

Search Clients Maximum number of simultaneous EAM Searchs for 
Microsoft Outlook® users.

Table 7.  ECM License Information

Attribute Name Description
Mailboxes Maximum number of mail users for which your mail 

server(s) are licensed.

Search Clients Maximum number of simultaneous ECM Search for 
Microsoft Outlook users.

LCM Enabled Indicates the ability to define Life Cycle Management 
(LCM) features. LCM provides the ability to define 
data retention policies. This feature is either enabled 
(yes) or disabled (no) for the entire ECM system.

EmailXtract Enabled Indicates that a license for the EmailXtract 
application is enabled. EmailXtract provides the 
ability to scan existing email and retroactively extract 
and archive it. This feature is either enabled (yes) or 
disabled (no).

RAID Capacity Maximum amount of space that can be used for 
archived email storage on a NAS. If you purchased 
an ECM bundle or an ECM standalone edition, this 
value does not apply.

Max Shelf Count Maximum number of shelves that can be used for 
archived email storage on library media.
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Email Regulatory Manager License Information
The following table describes each of the items that the License Server 
Administrator may display for an ERM license:

■ Monitoring License Usage
When users use the products that have been registered in the License Server 
Administrator, you can monitor the usage. The License Manager allows you to 
view what users are connected and pulling licenses for specific products. You 
can also log off connected users, if necessary. 

Table 8.  ERM License Information

Attribute Name Description
ERM Server 
Connections

The maximum number of concurrent ERM users, 
accessing documents generated by ERM.

ERM Servers Maximum number of ERM Servers that can be 
running simultaneously.

AFP Options Maximum number of available ERM Servers that can 
be used to convert AFP files and to extract index 
information from those files.

Metacode Options Maximum number of available ERM Servers that can 
be used to convert Metacode files and to extract 
index information from those files.

PCL Options Maximum number of available ERM Servers that can 
be used to convert PCL files and to extract index 
information from those files.

PDF Options Maximum number of available ERM Servers that can 
be used to extract index information from PDF files.

Business 
Intelligence 
Gateway Supported

Whether the Business Intelligence Gateway feature, 
which allows users to export ERM report data in a 
format that can be used in data mining applications, 
is enabled.

[Group Name] If license types for this product license are assigned 
to a license group, the groups to which those types 
are configured are listed below each license aspect 
in brackets. The quantity of that license type 
assigned to that group is also listed.
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To access the License Manager:

1. From the Tools menu, select License Manager. The License Manager 
dialog box appears.

Figure 18.  License Manager 

The License Manager lists each of the users who are using licensed 
products. For each user, the License Manager lists the following 
information:

• The user name

• The name of the computer on which the user is logged on

• The product or products being used

• The number of licensing options occupied by the user, and if 
applicable, the license group providing access (in brackets)

2. Click Refresh to refresh the contents of the Connection List (if users have 
logged on or logged off since the License Manager was opened).

3. If you want to log off a user, select the user from the list and click Logoff 
User. Then click Yes on the confirmation message that appears.

4. When you finish, click Close to close the License Manager.
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4Configuring and Managing 
License Groups

Licensing for some products allows for the ability to subdivide a license 
purchase across groups. A group can represent a department or any select 
set of users or groups of users. Using license groups, you can allocate 
purchased licenses to various groups, thereby limiting access and controlling 
license distribution throughout the enterprise. 

Once you register your product license information, you can create groups or 
pre-defined pools of license rights that allow you to subdivide licensed access 
to products and their functions, and subsequently to assign users of those 
products to specific license groups. This means that when those users log in 
to the associated product(s), they pull their product licenses (and the 
associated rights or limitations) from the license group to which they are 
assigned.

If users log in and are not assigned to use licenses from a specific group, 
those users pull access licenses from a group defined as [DEFAULT]. The 
[DEFAULT] license group contains all remaining license types that have not 
been assigned to license groups.

For more information, see the following sections:

• "Creating License Groups, " which follows

• “Adding Licenses to License Groups” on page 30

• “Editing License Groups” on page 32

• “Viewing License Group Information” on page 34

• “Monitoring License Group Usage” on page 35

• “Deleting Licenses from License Groups” on page 37

• “Deleting License Groups” on page 38

■ Creating License Groups
License groups can consist of only one type or aspect of a product license, or 
multiple aspects of a license, or even multiple product licenses (if the products 
work in conjunction with one another and both require separate licenses for 
each logged on user).
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Creating a license group is as simple as assigning a name to a group and then 
adding product licenses and/or product license aspects as appropriate.

To create a license group:

1. Right-click the Groups node in the tree view of the Administrator. From the 
shortcut menu, select New. The License Group Properties dialog box 
appears.

Figure 19.  License Group Properties Dialog Box 

2. In the License Group Name text box, enter the name for your license 
group. The name should be descriptive enough so that you can easily 
determine the function of the licenses in the group.

3. Click OK. The License Group Manager appears, with your newly created 
license group active in the Group drop-down list.

Figure 20.  License Group Manager 

The License Group Manager allows you to configure license types for the 
currently active license group. For more information, see "Adding Licenses to 
License Groups, " which follows.

■ Adding Licenses to License Groups
Adding licenses to a license group is what subdivides user access to those 
licenses. Adding the appropriate type and quantity of licenses to a particular 
group gives you a great deal of flexibility and control over what users have 
access to what types of product licenses and what functions those users are 
ultimately licensed to access.
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To add licenses to a license group:

1. From the Tools menu in the Administrator, select License Group Manager. 
The License Group Manager appears.

2. Be sure that the license group to which you want to add licenses appears 
in the Group drop-down list of the License Group Manager. 

Note: You can add a new license group by clicking the Add button and 
entering the new license group’s name in the License Group 
Properties dialog box. When you finish, click OK. 

3. When you have selected a license group in the License Group Manager, 
click Add License. The License Type Details dialog box appears.

Figure 21.  License Type Details Dialog Box 

4. Select the appropriate license type for the group from the License Type 
drop-down list. 

Note: If you did not purchase a particular aspect of a product license or if 
you have allocated all available instances of a license type, that 
type does not appear in the License Type drop-down list.

The License Type Details dialog box displays the following information for 
the selected license type:

• The total number of the selected license type originally purchased with 
the license

• The number of the selected license types that have already been 
assigned to other license groups.

5. In the Licenses Allocated To This Group text box, enter the number of the 
selected license type you want to assign to this license group. The number 
entered may NOT exceed the number of available license types (the Total 
Licenses Available minus the Licenses Used By Other Groups).

6. When finished, click OK. The License Group Manager appears with the 
added license type information.
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Figure 22.  License Group Manager 

7. Repeat steps 3 through 6 above for each additional license type you want 
to add to this license group.

8. When finished, you have two choices:

• If you want to add licenses to a different license group, select the 
group from the Group drop-down list and repeat steps 3 through 6 for 
each license type you want to add to that license group.

• If you are finished, click Done to return to the Administrator.

■ Editing License Groups
You can also edit license groups through the License Group Manager. You can 
change both the name of a group and the number of each license type 
configured for the group.

For more information, see the following sections:

• "Editing License Group Names, " which follows

• “Editing License Type Allocation for a License Group” on page 33

Editing License Group Names
You may change the name of a configured license group any time necessary. 
This may be particularly useful in the event you need to change what license 
types are configured for the group or change the title of the users accessing 
the group licenses.

Note: If you change the name of a license group in Email Content Manager, 
be sure to make the same change in the product whose users access 
the licenses. Otherwise the product will attempt to pull licenses from 
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the license group using the original group name, and license access 
will fail.

To change a license group name:

1. From the Tools menu in the Administrator, select License Group Manager. 
The License Group Manager appears.

2. Select the appropriate license group from the Group drop-down list.

3. Click Edit. The License Group Properties dialog box appears.

Figure 23.  License Group Properties Dialog Box 

4. In the License Group Name text box, type in the new name for the license 
group.

5. Click OK. The License Group Manager reappears, showing the new name 
for the license group in the Group drop-down list text box.

Editing License Type Allocation for a License Group
You can change the number of a selected license type allocated to a group. To 
remove a license type from a license group, see “Deleting Licenses from 
License Groups” on page 37.

To edit a license type’s allocation for a license group:

1. From the Tools menu in the Administrator, select License Group Manager. 
The License Group Manager appears.

2. Select the appropriate license group from the Group drop-down menu.

3. In the License Types list, highlight the appropriate license type and click 
Edit Licenses. The License Type Details dialog box appears.

Figure 24.  License Type Details Dialog Box 

The License Type Details dialog box lists the name of the selected license 
type, and the following information about the selected license type:
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• The total number of the selected license type originally purchased with 
the license

• The number of the selected license types that have already been 
assigned to other license groups

• The number of the selected license type assigned to this group

4. In the Licenses Allocated To This Group text box, edit the number of the 
selected license type assigned to this license group. The number entered 
may not exceed the number of available license types (the Total Licenses 
Available minus the Licenses Used By Other Groups).

5. When finished, click OK. The License Group Manager appears, listing the 
edited license type.

Note: If you attempt to decrease the number of allocated licenses to less 
than the number of current active connections for that type, you will 
receive a message warning you of that, and the License Reference 
Connection List dialog box will appear. You can use this dialog box to 
log off the appropriate number of connections in order to make the 
necessary edits to the number of allocated license types. See 
“Monitoring License Group Usage” on page 35 for more information.

■ Viewing License Group Information
After you have created a license group, you can use the Properties dialog box 
to view detailed information about the license group.

To display license group information:

• In the Groups node in the Administrator, double-click the license group for 
which you want to display information, or right-click the license group and 
then select Properties from the shortcut menu. The License Group 
Properties dialog box appears.
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Figure 25.  License Group Properties Dialog Box 

The License Group Properties dialog box has a single General tab. This tab 
lists all license types configured to the license group, and the number of types 
configured to the group out of the total number of connections allowed by each 
of the license types. 

■ Monitoring License Group Usage
The License Group Manager allows you to view current license group types 
and to manage user connections to those license types. You can also log off 
connected users, if necessary.
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To monitor license group usage:

1. From the Tools menu in the Administrator, select License Group Manager. 
The License Group Manager appears. 

Figure 26.  License Group Manager 

2. Select the group that you want to monitor from the Group drop-down list.

3. From the License Types list, select the license type for which you want to 
display the current connections and then click Show Connections. The 
License Reference Connection List dialog box appears.

Figure 27.  License Reference Connection List Dialog Box 

The License Reference Connection List dialog box displays a list of users 
currently connected to Email Content Manager and pulling the selected 
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license type from the selected group. It also lists the name of the license 
group and the name of the license type you selected.

4. Click Refresh to refresh the contents of the Connection List. This will 
update the Active Connections list if users have logged on or logged off 
since the dialog box was opened.

5. If you want to log off a user, select the user from the list and click Logoff 
User. Click Yes on the verification message appears.

6. When finished, click Close to return to the License Group Manager.

■ Deleting Licenses from License Groups
If you find you need to change what license types are assigned to a group, or 
simply need to remove a configured type from a group, you can delete license 
types from the group. The deleted license types are returned to the default 
pool of licenses.

To change what license types are configured for a license group, use the 
instructions in this section to delete currently configured license types, then 
use the instructions in “Adding Licenses to License Groups” on page 30 to add 
different license types to the group.

Note: You cannot delete license types from a group if there are users 
connected to that type in the group. Users must log off, or you can 
force a logoff of connected users. To force users to log off, see 
“Monitoring License Group Usage” on page 35.

To delete a license from a license group:

1. From the Tools menu in the Administrator, select License Group Manager. 
The License Group Manager appears.

Figure 28.  License Group Manager 
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2. From the Group drop-down list, select the license group whose license 
types you want to delete.

3. From the License Types list, select the license(s) you want to delete and 
click Delete License(s). Click Yes on the verification message appears.

4. The License Group Manager reappears, and the selected license types 
are deleted.

5. When finished, click Done to return to the Administrator.

■ Deleting License Groups
If you find you no longer have need of a license group, you may delete that 
group. 

Note: You must delete all license types from a group before deleting a 
license group. For more information, see “Deleting Licenses from 
License Groups” on page 37.

To delete a license group:

1. From the Tools menu in the Administrator, select License Group Manager. 
The License Group Manager appears.

Figure 29.  License Group Manager 

2. From the Group drop-down list, select the license group you want to delete 
and click Delete. A verification message appears.

3. Click Yes to delete the selected license group. The License Group 
Manager reappears, and the deleted license group no longer appears in 
the Group drop-down list.

4. When finished, click Done to return to the Administrator. The license group 
also no longer appears in the Groups node of the Administrator.
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5Managing the License Server 
Computer

License Server contains several functions that allow you to administer, 
diagnose, and troubleshoot License Server.

The Service Properties dialog box allows you to view information relating to 
the License Server installation on the selected computer, and you can 
configure alerts for the License Server computer.

Troubleshooting can be done using the diagnostic utilities in the Tools menu 
and the Service menu. You can look up error definitions in the Administrator 
using the Error Glossary feature. 

For more information, see the following sections:

• "Configuring License Server Service Properties, " which follows

• “Tracking Events, Errors and Warnings” on page 43

■ Configuring License Server Service Properties
You can view information relating to the License Server installation on the 
computer, as well as configure alerts for License Server warnings and errors.

To view License Server service properties:

1. From the Service menu, select Properties.

Figure 30.  Service Properties Dialog Box – General Tab 
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The Service Properties dialog box contains the following tabs:

• "The General Tab, " which follows

• “The Alerts Tab” on page 40

2. When you finish, you have three options:

• To save changes and close the Properties dialog box, click OK.

• To save changes and keep the Properties dialog box open, click Apply.

• To discard all changes made since the Properties dialog box was 
opened (or since the Apply button was used) and close the Properties 
dialog box, click Cancel. 

The General Tab
The General tab of the Service Properties dialog box displays identifying 
information for the License Server computer, as described in the following 
table:

The Alerts Tab
The Alerts tab of the Service Properties dialog box allows you to configure 
License Server to send alerts to specific users, workstations, email addresses, 
or domains. An alert is a message box that appears notifying the recipient of 
an error or warning on the License Server system. 

Figure 31.   Example Alert 

Alerts can be sent to a specific computer or user, to an entire domain, or to an 
email address.

Table 9.  Service Properties Dialog Box – General Tab Items

Item Description
Computer Name The Windows computer name for the License Server 

computer

Installation Date The date that License Server was installed (or 
updated)

Version The installed version of License Server

Machine ID The machine ID for the License Server computer
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A default alert for both warnings and errors is created for the License Server 
computer when License Server is installed. 

To configure alerts:

1. Click the Alerts tab on the Service Properties dialog box.

Figure 32.  Service Properties Dialog Box – Alerts Tab 

2. You have the following choices:

• Add an alert. For more information, see "Adding an Alert, " which 
follows.

• Edit an existing alert. For more information, see “Editing an Alert” on 
page 43.

• Delete an alert. For more information, see “Deleting an Alert” on 
page 43.

3. If you configured any email alerts, enter the name of the mail server being 
used to deliver the alerts in the Mail Server text box at the bottom of the 
Alerts tab. The well-known port for SMTP servers is supported, so no 
additional configuration should be required for use with mail servers, 
routers, or firewalls.

Note: An email client must be installed on the License Server computer 
on which you are configuring the alert in order for email alerts to 
work. 

Adding an Alert
To send alerts to specific users, workstations, email addresses, or domains, 
you need to add an alert from the Alerts tab of the Service Properties dialog 
box.
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To add an alert:

1. On the Alerts tab, click Add. The Alert Settings dialog box appears. 

Figure 33.  Alert Settings Dialog Box 

2. From the Type drop-down list box, select the type of alert that you would 
like to configure. You have the following choices:

• Computer

• Domain

• Email

• User

3. In the Send To text box, enter the email address, domain name, user 
name, or computer name to which you want alerts sent. 

4. Below the Send To box you may configure the following options:

• If you want the alert to be sent for warnings and errors, enable both the 
Notify warnings and Notify errors check boxes.

• If you want an alert to be sent for warnings but not for errors, enable 
the Notify warnings check box.

• If you want an alert to be sent for errors but not warnings, enable the 
Notify errors check box.

• If you want to temporarily disable the alert, disable both the Notify 
warnings and Notify errors check boxes. You can enable either of 
these options at a later time.

5. When you are finished choosing the alert settings, click Add. The 
information in the Send To box disappears, and the recipient is added to 
the alerts listing. 

6. You have the following choices:

• Repeat steps 2 through 5 to add another alert. 

• If you are finished configuring alerts, click Close on the Alert Settings 
dialog box. The alert appears in the Alert list in the Alerts tab. 
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Editing an Alert
Once alerts have been established, you can edit them.

To edit an alert:

1. On the Alerts tab of the Service Properties dialog box, select the alert you 
want to edit and then click Edit. The Alert Settings dialog box appears.

Figure 34.  Alert Settings Dialog Box -- Editing an Alert 

2. You have the following choices:

• To change the type of alert that is sent, select a type from the Type 
drop-down list box.

• To change the email address, domain name, user name, or computer 
name to which you want alerts sent, enter the new value in the Send 
To text box.

• To change whether warnings are sent as alerts, enable or disable the 
Notify warnings check box.

• To change whether errors are sent as alerts, enable or disable the 
Notify errors check box.

3. When you finish editing the alert, click OK. The edited alert appears in the 
Alert list in the Alerts tab.

Deleting an Alert
If you no longer need an alert, you can delete it.

To delete an alert:

1. On the Alerts tab of the Service Properties dialog box, select the alert you 
want to delete and then click Delete. A confirmation message appears.

2. Click Yes.

■ Tracking Events, Errors and Warnings
License Server has built-in utilities for monitoring events, errors, and warnings. 
The Event Viewer contains a listing of all License Server events, errors, and 
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warnings. This information is also logged to event logs. Errors and warnings 
are logged automatically, while License Server must be configured to log other 
events.

The Event Viewer and the event logs provide a quick look at the activities of 
License Server. They allow you to monitor all aspects of License Server 
events. Logs can help identify and solve potential problems during runtime 
that might otherwise become critical problems if ignored. If the Event Viewer 
and event logs become large and cumbersome to navigate, you can clear 
them.

For more information, see the following sections:

• "Using the Event Viewer, " which follows

• “Using Event Logs” on page 44

• “Looking up Errors” on page 46

• “Configuring Event Logging” on page 46

• “Clearing the Event Viewer and Event Logs” on page 50

Using the Event Viewer
The Event Viewer displays all events for License Server. If you do not want to 
automatically save a record of the events on License Server, you can disable 
event logging in the Service Event Configuration dialog box and simply 
monitor events in the Event Viewer. For more information on disabling event 
logging, see “Configuring Event Logging” on page 46.

You can also take a “snapshot” of the contents of the Event Viewer and save it 
for later use. A snapshot is a capture of up to the last 2,048 lines of the Event 
Viewer.

To open the Event Viewer:

• From the Service menu, select Event Viewer.

To take a snapshot of the Event Viewer:

• From the File menu in the Event Viewer, select Snapshot. The snapshot 
appears in RtfPad. You can save, print, and email the snapshot from 
RtfPad. For more information, see “Using RtfPad” on page 85.

Using Event Logs
In addition to the viewing capabilities offered by the Event Viewer, License 
Server also contains three event logs that save events, errors, and warnings 
for the License Server computer to log files. 
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• The All Events Log lists all activities on the License Server service. Event 
logging is useful to trace License Server service events of interest to you. 
You can configure which events are traced. 

• The Errors Only Log lists only License Server system errors and is a useful 
tool for detecting and diagnosing those errors. 

Note: You can use the System Error Lookup feature to obtain additional 
information about each error, including the error’s name and 
description, and to quickly translate error codes that appear in 
License Server. For more information, see “Looking up Errors” on 
page 46.

• The Warnings Only Log lists only License Server system warnings to warn 
you of possible problems in License Server. The purpose of this list is to 
provide a simpler means of discovering where problems exist that are 
hindering License Server performance.

Errors and warnings also appear in the Event Viewer, but the Errors Only Log 
and Warnings Only Log provide a more precise focus on these important 
events. You can also configure errors and warnings to be sent out as alerts to 
a specific domain, user, computer, or email address so that you are 
automatically notified when they occur. For more information, see “The Alerts 
Tab” on page 40.

Because they are necessary for system diagnostics, error and warning logging 
cannot be disabled. If technical support is needed, you may be asked to open 
these logs and specify the information reported.

When opened, the logs slow down License Server performance. When closed, 
the impact they have on performance is insignificant. The logs should be 
opened and used only for debugging purposes.

Note: Because tracing events impedes system performance, no events are 
traced by default, though errors and warnings are logged automatically 
because of their necessity for troubleshooting. For more information, 
see “Configuring Event Logging” on page 46.

To open a log:

1. From the Service menu, select Event Logs. A shortcut menu appears.

2. Select the log you want to view. You have the following choices:

• All Events

• Warnings Only

• Errors Only

The selected log appears in RtfPad. The log displays both the time and a 
message for each event. The most recent events are last on the list (the 
list automatically scrolls to display the most current events).
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3. You can save, print, and email the log from RtfPad. For more information, 
see “Using RtfPad” on page 85.

4. When you finish, open the File menu in RtfPad and then select Exit to 
close the log.

Looking up Errors
Each License Server error is displayed as an error number. The License 
Server error lookup feature allows you to obtain additional information about 
the error, including the error name and description, and to quickly translate the 
error codes provided in License Server messages.

To look up an error:

1. You have the following choices:

• In the Administrator window, open the Help menu and then select Error 
Glossary, or press <CTRL>+E. The System Error Lookup dialog box 
appears. Enter the error number in the Error Number text box and click 
Look Up.

• Highlight the error code number in the event log and then press F2 or 
select Error Lookup from the RtfPad View menu.

The error string (if applicable) and its description are displayed in the 
System Error Lookup dialog box.

Figure 35.  System Error Lookup Dialog Box 

2. You have the following choices:

• Click the forward or backward arrow buttons to scroll through the list of 
system errors. 

• When you finish, click Close to exit the dialog box.

Configuring Event Logging
Event logging is necessary only when tracing events of interest to you. You 
can configure which events are traced. Because tracing events impedes 
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system performance, no events are traced by default, though errors and 
warnings are logged automatically because of their necessity for 
troubleshooting.

License Server allows you to configure which events are logged, and whether 
to trace the local service events or remote procedure calls (remote 
administration events). 

For all logs, you can control the format of the log entries, and adjust the 
maximum sizes for the log files. For the All Events Log, you can disable 
logging and enable the tracing of events upon startup. You can enable logging 
to the Windows Application Log for the Warnings Only Log and the Errors Only 
Log.

For more information, see the following sections:

• "Log Properties Configuration, " which follows

• “Event Tracing Configuration” on page 49

Log Properties Configuration
You can control several aspects of logging functionality, including log entry 
format, log file size, event logging, automatic startup of event logging, and 
logging of errors and warnings to the Windows Application Log. 

To configure log properties:

1. From the Service menu, select Event Settings. The Service Event 
Configuration dialog box appears. The Configuration tab is active by 
default.

Figure 36.  Service Event Configuration Dialog Box – Configuration Tab 
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2. In the Line Format section, specify logging of particular event attributes. 
These options are enabled by default. You have the following choices:

• To disable logging the time each event occurs, disable the Time check 
box.

• To disable logging the date each event occurs, disable the Date check 
box.

• To disable logging the thread the event used to communicate with the 
processor, disable the Thread ID check box.

3. In the Event Log section, configure logging to the All Events Log. Event 
logging is enabled by default; however, no events are traced. For 
information on selecting events to trace, see "Event Tracing Configuration, 
" which follows. You have the following choices to configure event logging:

• To change the maximum size in megabytes (MB) for the log file, enter 
a new value in the Maximum Log Size text box. The default size is 5 
MB. After the maximum log size is reached, the log is truncated from 
the beginning of the file (oldest events).

• To disable logging to the All Events Log, enable the Disable log file 
(viewer only) check box. Events are still logged to the Event Viewer.

• To automatically initiate event logging when License Server is started, 
enable the Trace messages on startup check box.

4. In the Warning Log section, configure logging to the Warnings Only Log. 
You have the following choices:

• To change the maximum size in MB for the log file, enter a new value 
in the Maximum Log Size text box. The default size is 5 MB. After the 
maximum log size is reached, the log is truncated from the beginning 
of the file (oldest events).

• To enable logging of License Server warnings to the Windows 
Application Log, enable the Write to Windows Application Log check 
box. Since License Server warning logs are cleared when the service 
is restarted, this allows the Windows Application Log to maintain a 
running log for License Server warnings outside of the License Server 
service. 

Note: To access the Windows Application Log, open the Start menu. 
Then select Programs, Administrative Tools, and Event Viewer.

Note: You cannot disable logging to the Warnings Only Log and Errors 
Only Log.

5. In the Error Log section, configure logging to the Errors Only Log. You 
have the following choices:
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• To change the maximum size in MB for the log file, enter a new value 
in the Maximum Log Size text box. The default size is 5 MB. After the 
maximum log size is reached, the log is truncated from the beginning 
of the file (oldest events).

• To enable logging of License Server errors to the Windows Application 
Log, enable the Write to Windows Application Log check box. Since 
License Server error logs are cleared when the service is restarted, 
this allows the Windows Application Log to maintain a running log for 
License Server errors outside of the License Server service.

Note: To access the Windows Application Log, open the Start menu. 
Then select Programs, Administrative Tools, and Event Viewer.

6. You have the following choices:

• If you want to begin tracing events, click Apply to save your changes 
and the select the Trace tab. For more information on tracing events, 
see "Event Tracing Configuration, " which follows.

• If you are finished configuring log properties, click OK to save your 
changes and close the Service Event Configuration dialog box.

Event Tracing Configuration
You can configure which events are to be traced and reported to the Event 
Viewer and the All Events Log. By default, all event tracing is disabled. Unless 
instructed to enable tracing of events by a technical support representative, 
you can leave the default settings in place. 

Note: Event tracing configuration affects events only; errors and warnings 
relating to events of the types listed are logged regardless of event 
tracing settings. 

Note: Enabling event tracing hinders performance and should be performed 
only when debugging is required. 

To configure events to be logged:

1. From the Service menu, select Event Settings. The Service Event 
Configuration dialog box appears. 

2. Click the Trace tab. The System drop-down list displays Server Processing 
by default. 
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Figure 37.  Service Event Configuration Dialog Box – Trace Tab 

3. From the System drop-down list, select whether to trace Server 
Processing (local machine service events) or Remote Procedure Calls 
(remote administration service events). 

4. In the Options list, enable the check box next to an event to begin tracing 
that event.

5. When you are finished, click OK to save the new settings and close the 
Service Event Configuration dialog box. 

Clearing the Event Viewer and Event Logs
You can manually clear the information in the Event Viewer and the event 
logs. Event logs have a specific size limitation, after which the log is truncated 
from the beginning of the file. While the log size is regulated through automatic 
truncation (see Log Properties Configuration for more information), large logs 
are often cumbersome and difficult to navigate. Clearing event logs regularly 
makes it easier to find new information.

Note: You may want to save your log before clearing it. To save a log, open it 
and then select Save from the File menu in RtfPad.

To clear the Event Viewer or an event log:

1. From the Service menu, select Event Logs. A shortcut menu appears.

2. You have the following choices:

• To clear the Event Viewer and the All Events Log, select Clear Event 
Log.

• To clear the Warnings Only Log, select Clear Warning Log.
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• To clear the Errors Only Log, select Clear Error Log. 

3. Click Yes on the confirmation message that appears.
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6Running License Server 
Reports

The License Server reporting feature is a useful tool for tracking system 
statistics. Using the Report Wizard, you can create the following reports of 
system activities:

• The Server Registry Information report displays a listing of all registry keys 
and associated values used by License Server. 

• The Licensing Information report displays information about the licenses 
available for all products registered with License Server.

• The Licensing Group Information report displays information about the 
configured license groups and the license types allocated to each.

You can also create custom layouts for your reports. Custom layouts are 
particularly useful because they can be saved and reused every time you run 
a report.

Since License Server is designed to allow you to manage multiple registered 
License Server computers from a single Administrator interface, you can run 
any one of the available reports on multiple computers. You can also run more 
than one report at a time, allowing you to view several different aspects or 
details about several different registered License Server computers in one 
consolidated report.

For more information, see the following sections:

• "Creating Reports, " which follows

• “Report Layout Editor” on page 56

■ Creating Reports
The Report Wizard allows you to create various reports of system activities on 
one or more registered (and connected) License Server computers. It also 
allows you to select to run more than one report at a time, allowing you to view 
several different aspects, or details about several different registered 
computers, in one consolidated report.
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To create a License Server report:

1. From the Tools menu in the Administrator, select Report Generator, or 
press <CTRL>+R. The Report Generator Wizard appears, starting with the 
Select Report(s) To Run page.

Figure 38.  Report Wizard – Select Report(s) To Run Page 

A description of the report appears as a pop-up text box when you rest the 
mouse pointer on any report option.

2. Select the appropriate report type(s). You have the following choices:

• To display a listing of all registry keys and associated values used by 
License Server, select Server Registry Information.

• To display information about the licenses available for all products 
registered with License Server, select Licensing Information.

• To display information about configured license groups available and 
their allocated license types, select Licensing Group Information.

3. Click Next. The Select Computer(s) page appears, which lists all 
registered and connected License Server computers.
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Figure 39.  Report Wizard – Select Computer(s) 

4. From the Computer list, select the License Server computer(s) for which 
you want to generate the report.

5. Click Next. The Options page appears.

Figure 40.  Report Wizard – Options Page 

6. If there is more than one layout/computer listed, select the one you want to 
use for your report. To edit a selected layout, click Edit Layouts. For 
instructions, see "Report Layout Editor, " which follows.

7. Select the amount of detail you want on the report: Full or Summary.

8. Click Next. The summary page appears.

9. Review the information and click Finish to create and display the report. 
RtfPad automatically opens, displaying the report. As with any information 
appearing in RtfPad, you may choose to save the report, print the report, 
or send the report by email. For details on these functions, see “Using 
RtfPad” on page 85.
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■ Report Layout Editor
The Report Layout Editor allows you to define the font, font sizes, tab stops, 
and header and footer contents for License Server reports. The styles and 
layouts can be set and saved as report defaults; however, you can override 
these options whenever necessary. 

License Server also allows you to create and save new layouts on different 
License Server computers. These layouts are available for use any time a 
report is run for that License Server computer, regardless of whether the 
report is being run from that License Server computer or from a remote 
License Server computer.

To customize report layouts:

1. You have the following choices:

• If you are in the process of running a report and you want to edit an 
existing layout, select the layout on the Options page of the Report 
Generator Wizard and then click Edit Layouts.

• If you are in the process of running a report and you want to create a 
new layout, on the Options page of the Report Generator Wizard, click 
Edit Layouts.

• If you are not in the process of running a report, open the Tools menu 
and then select Report Layouts. 

The Report Layout Editor dialog box appears.

Figure 41.  Report Layout Editor 

2. You have the following choices:

• Create a new layout. For more information, see "Creating a New 
Layout, " which follows.

• Change the header or footer for a report layout. For more information, 
see “Changing Headers and Footers for Layouts” on page 57.



Report Layout Editor

ASM License Server System Guide 57
StorageTek Proprietary

• Edit layout styles. For more information, see “Editing Layout 
Paragraph Styles” on page 59.

• Rename a layout. For more information, see “Renaming a Layout” on 
page 61.

• Switch from one layout to another. For more information, see 
“Switching from One Layout to Another” on page 62.

• Preview a layout. For more information, see “Previewing a Layout” on 
page 62.

• Delete a layout. For more information, see “Deleting a Layout” on 
page 63.

Creating a New Layout
Creating a layout is as simple as giving it a name. When creating a layout, 
remember that each layout should be identified by a descriptive name to make 
the layout easy to identify for use with your reports. 

To create a new layout:

1. In the Report Layout Editor dialog box, click New. The Enter New Layout 
Name dialog box appears.

Figure 42.  Enter New Layout Name Dialog Box 

2. In the text box, type a name. Click OK. A new layout is created with that 
name and the default layout settings. To modify the default settings, see 
the following sections: 

• "Changing Headers and Footers for Layouts, " which follows

• “Editing Layout Paragraph Styles” on page 59

Changing Headers and Footers for Layouts
You can configure a customized header and footer for each report layout using 
the Report Layout Editor. 

The header and footer can contain dynamic codes that retrieve specific 
values, such as date, time, user name, and domain, and write them directly 
into the header or footer. Placing these dynamic codes in custom headers or 
footers, and thereby on the reports generated with a custom layout, can help 
you identify, file, and retrieve reports later.
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To change a header or footer for a layout:

1. Verify that the correct report appears in the Name drop-down list in the 
Report Layout Editor.

2. Click in either the Header Text box or the Footer Text box and type or edit 
the desired text. 

3. To insert a dynamic code in the text, place the cursor in the Text box where 
you want the code value to appear. If you do not want to insert a dynamic 
code in the text, skip to step 7.

4. Click Insert Code under the appropriate text box. The Select Report Code 
to Insert dialog box appears.

Figure 43.  Select Report Code To Insert 

5. Select the code that you want to insert. You have six options:

6. Click OK to insert the code and return to the Report Layout Editor dialog 
box.

Note: Spaces are not automatically inserted around the code. If you want 
spaces to appear before or after the value the code inserts, place 

Table 10.  Report Code Options

Option Description
User name Inserts the name of the currently logged in Windows 

user

Network domain Inserts the domain on which License Server is running

Date Inserts the system date on which the report is 
generated

Time Inserts the system time on which the report is 
generated

Report name Inserts the name given to the report when generated

Product version Inserts the version of License Server being used to 
generate the report
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spaces in the text box before and after the code where you want 
spaces to appear.

7. Choose whether to use a dotted line as a divider between the header or 
footer and the report body.

• If you do not want a dotted line to separate the header from the report 
body, disable the Use divider below header check box. This option is 
enabled by default.

• If you do not want a dotted line to separate the footer from the report 
body, disable the Use divider above footer check box. This option is 
also enabled by default.

8. You have the following choices:

• To preview the report layout, click Preview.

• To save changes and keep the Report Layout Editor dialog box open, 
click Update.

• To save changes and close the Report Layout Editor dialog box, click 
OK.

Editing Layout Paragraph Styles
The Report Layout Editor allows you to customize the look of your reports by 
giving you font, size, color, and other stylistic options for each type of 
paragraph used in generating report output. This makes it easier to call 
attention to specific information in the reports and may make your reports 
easier to read and interpret.

To edit styles for a layout:

1. Verify that the correct report appears in the Name drop-down list in the 
Report Layout Editor.

2. Click Edit Styles. The Report Layout - Styles dialog box appears. 

Figure 44.  Report Layout - Styles Dialog Box 
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Each paragraph type has a drop-down list containing all available style 
profiles. 

3. You have the following choices:

• To use an existing style profile, select the profile from the drop-down 
list next to the paragraph type you want to edit.

• To create a new profile, click the Edit button to the right of profile drop-
down list. The Report Style Editor dialog box appears.

Figure 45.  Report Style Editor Dialog Box 

Select the desired characteristics for Font, Font Size, Text Color, and 
Alignment from the appropriate drop-down lists. 

Enable or disable the Underline and Bold characteristics for the paragraph 
by clicking in the check box next to each option. 

Click OK to save your changes to the paragraph style and return to the 
Report Layout - Styles dialog box. Your new style properties appear in the 
profile drop-down list.

4. Once you have configured all necessary styles, you can preview the report 
layout by selecting the Preview button on the Report Layout - Styles dialog 
box. A Report Layout Preview appears in RtfPad.
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Figure 46.  Report Layout Preview – Sample Report 

5. When you are satisfied with your layout styles, click OK to save changes 
and return to the Report Layout Editor dialog box.

Renaming a Layout
If necessary, you can rename an existing custom layout.

To rename a layout:

1. In the Report Layout Editor dialog box, make sure that the correct layout 
appears in the Name text box.

2. Click Rename. The Enter New Layout Name dialog box appears.

Figure 47.  Enter New Layout Name Dialog Box 

3. In the text box, type the new name. 

4. Click OK. The new name appears in the Name text box in the Report 
Layout Editor dialog box.
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Switching from One Layout to Another
If you have created or made edits to a report layout and you want to create or 
edit another one, you should click Update to save your changes. If you select 
another layout from the Name drop-down list or click New without clicking the 
Update button, License Server prompts you to save unsaved changes to the 
current layout. 

Figure 48.  Save Changes? 

To save changes, click Yes. Or, to discard changes that you have made since 
the last time you clicked Update, click No.

Previewing a Layout
You can preview a report layout so that you know what the report will look like 
before you run it.

To preview a layout:

1. In the Report Layout Editor dialog box, make sure the correct layout 
appears in the Name text box.

2. Click Preview. A Report Layout Preview appears in RtfPad. 

Figure 49.  Report Layout Preview – Sample Report 
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3. When you finish, close the preview by selecting Exit from the RtfPad File 
menu.

Deleting a Layout
If you no longer need a custom report layout, you can delete it.

To delete a layout:

1. In the Report Layout Editor dialog box, make sure the layout you want to 
delete appears in the Name text box.

2. Click Delete. A confirmation message appears. 

3. Click Yes.
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7License Server Backup and 
Recovery

Because constant and reliable access to your data is one of the most critical 
parts of your system, we recommend that you have a comprehensive disaster 
recovery plan in place in the event of system problems or an entire system 
shutdown. License Server contains a registry utility that can help you restore 
the License Server configuration, even when the problem is a minor one.

For more information, see the following sections:

• "Backing up Your License Server System, " which follows

• “Restoring Your License Server System” on page 68

■ Backing up Your License Server System
You can create a backup of your License Server system configuration, which 
is stored in registry settings, when needed using the repair disk utility. In the 
event of a License Server computer crash, you can then use the registry 
backup to restore the License Server configuration.

The repair disk utility can be used to create a backup copy of the registry 
information for the License Server system. License Server automatically 
updates the repair disk backup every 15 minutes and every time the service is 
stopped and started. You can set the location where the repair disk is 
automatically saved, set a location for a copy of the repair disk for the current 
License Server configuration, or restore License Server registry settings using 
the Repair Disk Wizard.

This section provides procedures for setting the backup location for your 
repair disk and for creating a copy of the repair disk backup. For more 
information, see the following sections:

• "Setting the Repair Disk Backup Location, " which follows

• “Copying the Repair Disk Backup” on page 67

For information and instructions on restoring a repair disk file, see “Restoring 
License Server Configuration” on page 69.
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Setting the Repair Disk Backup Location
The Repair Disk Wizard allows you to designate where License Server stores 
the repair disk backup it creates. In order to ensure fail-proof disaster 
recovery, the backup should be copied to a location separate from your 
Windows server files. Ideally, you should copy it to a different volume.

Note: The repair disk backup should be backed up regularly to an additional 
location.

To set the repair disk location:

1. From the Tools menu, select Repair Disk. The Repair Disk Wizard 
appears.

Figure 50.  Repair Disk Wizard -- Introduction Page 

2. Choose Set the automatic repair disk location and then click Next. The 
Automatic Repair Disk Location page appears.

Figure 51.  Repair Disk Wizard – Automatic Repair Disk Location Page 

3. In the Location text box, enter the directory to which the repair disk backup 
should be saved. To browse to a directory, click Browse. You must use a 
UNC path.
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4. Once you have entered a path in the Location text box, click Next. The 
summary page appears.

5. Review the information in the summary.

6. If the information in the summary is correct, click Finish to complete the 
wizard. A progress message appears, indicating that the auto disk repair 
location is being saved. Once the message disappears, the location 
setting is complete.

Copying the Repair Disk Backup
In addition to designating where the repair disk backup is stored, the Repair 
Disk Wizard also allows you to store a copy of the current repair disk at will. 
When you use the Repair Disk Wizard to set a location for a copy of the 
current configuration, License Server creates a copy of the License Server 
configuration as soon as the wizard is completed. The copy is a one-time 
backup and does not update regularly.

Note: Setting a location for a copy of the current configuration does not affect 
the location for automatic backup. License Server continues to back up 
License Server registry information to the location set for automatic 
repair disk creation. 

To copy the current repair disk backup:

1. From the Tools menu, select Repair Disk. The Repair Disk Wizard 
appears.

Figure 52.  Repair Disk Wizard -- Introduction Page 

2. Select Copy current repair disk information to another location and then 
click Next. The Copy Repair Disk Information page appears.



License Server Backup and Recovery

68 Second Edition
StorageTek Proprietary

Figure 53.  Repair Disk Wizard – Copy Repair Disk Information Page 

3. Enter a directory path and file name in the File Name text box. To browse 
to a directory and/or file, click Browse.

4. Once you have entered a path in the File Name text box, click Next. The 
summary page appears.

5. Review the information in the summary.

6. If the information in the summary is correct, click Finish to complete the 
wizard. A progress message appears, indicating that the copy disk repair 
location is being saved. Once the message disappears, the copy is 
complete.

■ Restoring Your License Server System
In the event of catastrophic system failure, the same License Server utility that 
allows you to create backups of your registry settings also allows you to 
restore those backups to your License Server system. The restore function for 
the repair disk utility makes recovery and re-configuration of your system after 
a disaster both faster and more accurate.

This section provides information and procedures for restoring the registry 
configuration in the event you ever need to restore your License Server 
system after a disaster or catastrophic system failure.

When a system failure or disaster occurs, the following steps should be taken 
in order to most effectively restore your License Server system.

To restore your License Server system:

1. If necessary, reformat the License Server computer hard drive.

2. Reinstall Windows.

3. Reinstall License Server. For instructions, see “Installing License Server” 
on page 1.
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4. Restore the repair disk (License Server registry) file. For instructions, see 
"Restoring License Server Configuration, " which follows.

These steps should be sufficient to get your License Server system back up 
and running after a disaster or system failure. As always, however, if you run 
into any problems, contact your technical support representative for 
assistance.

Restoring License Server Configuration
When a system failure or disaster occurs on your License Server computer, 
you can restore your License Server registry configuration by using the Repair 
Disk Wizard to restore the backup copy of the registry settings after you have 
reinstalled all of the necessary software components.

To restore the registry configuration:

1. From the Tools menu, select Repair Disk. The Repair Disk Wizard 
appears.

Figure 54.  Repair Disk Wizard -- Introduction Page 

2. Choose Restore service configuration from a repair disk and click Next. 
The Restore Repair Disk page appears.

Figure 55.  Repair Disk Wizard – Restore Repair Disk Page 
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3. Enter the directory path and file name for the repair disk file in the File 
Name text box. To browse for a file, click Browse.

4. Click Next. The Restore Repair Disk – Warning page appears.

Figure 56.  Repair Disk Wizard – Warning Page 

5. Read the Restore Repair Disk – Warning page carefully.

6. When you finish, click Next. The Restore Repair Disk – Note page 
appears. 

Figure 57.  Repair Disk Wizard – Note Page 

This page provides a reminder that the current product configurations will 
be overwritten with the saved configuration from the specified repair disk 
location.

7. To continue, click Next. The summary page appears.

8. Review the information in the summary carefully.

9. If the information in the summary is correct, click Finish to complete the 
wizard. The registry information is copied, and the backup License Server 
configuration is restored to your machine.

10. Restart the License Server computer. 
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After restoring your License Server system, you may want to run one or more 
of the available License Server reports to make sure that your system has 
been returned to the appropriate state. For more information, see “Creating 
Reports” on page 53.



License Server Backup and Recovery

72 Second Edition
StorageTek Proprietary



ASM License Server System Guide 73
StorageTek Proprietary

8Remotely Administering 
License Server

You can administer License Server computers both from the computer on 
which License Server is installed and from remote computers. You can use the 
Administrator function that comes with a full installation of License Server to 
administer other License Server computers, or you can install the Remote 
Administrator, which simply provides you with the Administrator interface and 
the registration capability to attach remotely to one or more networked License 
Server computers. The remote administration function is the same whether 
you use a License Server Administrator (full installation) or a Remote 
Administrator. 

The License Server computer(s) you plan to manage must be the same 
version as the Remote Administrator. 

For more information, see the following sections:

• "Before Installing the Remote Administrator, " which follows

• “Installing the Remote Administrator” on page 74

• “Starting the Remote Administrator the First Time” on page 78

• “Registering a Computer for Remote Administration” on page 78

• “Connecting to License Server Computers” on page 83 

For information on uninstalling the Remote Administrator, see “Uninstalling 
License Server Components” on page 91. For more information on navigating 
through the Administrator window, see “Working in the Administrator” on 
page 9.

■ Before Installing the Remote Administrator
Before you install the Remote Administrator, you need to consider the 
following requirements:

• "Operating System Requirements, " which follows

• “Windows Security” on page 74

• “Clustering” on page 74
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Operating System Requirements
License Server, including the License Server Remote Administrator, requires 
one of the following operating systems on the computer:

• Windows 95 (OSR 2)

• Windows 98

• Windows NT 4.0 (Service Pack 6a)

• Windows 2000 (Service Pack 2 or higher)

• Windows XP

Consult your Windows operating system documentation for information on 
running the installation.

Windows Security
Remote administration of License Server computers works through a Remote 
Procedure Call (RPC) connection that enables communication between a 
remote License Server Administrator and the License Server computer. 
Security for that connection is managed by managing the membership of the 
local domain Administrators group. To administer the License Server functions 
through a remote installation of the License Server Administrator, you must be 
a member of the Administrators group on the License Server computer.

In addition, for your convenience, the Remote Administrator Setup Wizard 
allows you to install the Remote Administrator on multiple computers at once, 
provided those computers are visible on your network and you are a member 
of the local Administrators group on those computers. To take advantage of 
this feature, you may want to determine which computers are to have the 
Remote Administrator installed on them and make sure you have 
administrative privileges on those machines before you run the setup wizard. 
This will enable you to run the installation only once rather than multiple times.

Clustering
If you choose to install the Remote Administrator in a clustered environment, 
install the program on the Primary server. Once the installation is replicated to 
the Secondary server, register each computer you want to remotely administer 
on both the Primary server and the Secondary server.

■ Installing the Remote Administrator
For Remote Administrator workstations connecting to a License Server 
computer, a full License Server setup is not necessary. Connecting 
workstations need access to the Administrator only. A Remote Administrator 
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installation sets up the Administrator module as well as online help on the 
workstation. 

To install the Remote Administrator:

1. Exit all applications on the computer(s) on which you want to install the 
Remote Administrator. The Remote Administrator Setup Wizard may not 
be able to write to all necessary files if other software is running.

2. Insert any ASM setup CD-ROM into the drive. From the Start menu, select 
Run. The Run dialog box appears.

3. From the Windows Start menu of the computer on which you want to install 
License Server, select Run. The Run dialog box appears.

4. In the Open text box, click Browse to browse to the location of the Remote 
Administrator setup files. 

5. Click OK. The Remote Administrator Setup Wizard is initiated (which may 
take up to two minutes), and the Installation page appears. The Installation 
page briefly describes the installation process. 

6. Click Next. The Installation Options page appears.

Figure 58.  Remote Administrator Setup Wizard – Installation Options 
Page 

7. Select Install new product and then click Next. The License Agreement 
page appears. 
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Figure 59.  Remote Administrator Setup Wizard – License Agreement 
Page 

8. You must accept the terms of the license agreement before you can 
proceed with the installation. Enable the check box next to Accept terms of 
agreement and then click Next. The Registration page appears.

Figure 60.  Remote Administrator Setup Wizard – Registration Page 

9. Enter your name and the name of your organization and then click Next. 
The Target Computers page appears.
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Figure 61.  Remote Administrator Setup WIzard -- Target Computers 
Page 

10. You have the following choices:

• To install the Remote Administrator only on the computer listed in the 
Target Computers list, click Next. The summary page appears.

• To install the Remote Administrator on other computers in addition to 
the one listed in the Target Computers list, click Add. The Browse 
Computers dialog box appears.

11. In the Browse Computers dialog box, you have two choices:

• Under Available Computers, navigate to and select the computer on 
which you want to install the Remote Administrator and then click Add 
to add the computer to the Selected Computers list. 

• In the Computer Name text box, type in the name or the IP address of 
the computer on which you want to install the Remote Administrator 
and then click Add to add the computer to the Selected Computers list.

Repeat this step for each additional computer on which you want to install 
the Remote Administrator. When you finish selecting target computers, 
click OK. You are returned to the Select Target Computers page. Click 
Next. The summary page appears. 

12. Verify the accuracy of the information in the summary.

13. If all information is correct, click Finish. The Remote Administrator Setup 
Wizard copies all program files onto the system, and adds Remote 
Administrator entries and the program group to the system configuration 
for the selected target computer(s). A progress bar displays the status of 
the operation. 

When the installation is complete, one of the following occurs: 

• If you are not required to restart the computer, a message appears, 
indicating that the Remote Administration installation has been 
successfully completed. Click Start to close the Remote Administration 
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Setup Wizard and open the Administrator, or click Exit to close the 
Remote Administration Setup Wizard without starting the 
Administrator.

• If you are required to restart the computer or if the installation fails on 
one or more computers, the License Server Administrator Setup 
Result dialog box appears, listing the installation results for each 
computer you specified. 

Take note of any computers that need to be restarted (or computers on 
which the installation failed) and then click OK. Be sure to restart each 
computer on which it is required before you start the Remote 
Administrator.

■ Starting the Remote Administrator the First Time
Because the Remote Administrator functions as an interface for License 
Server services installed on other machines, you must register the other 
computers through the Administrator in order to use the remote functionality.

To start the Remote Administrator:

1. From the Start menu, select Programs, License Server Administrator, and 
then Administrator. The first time you start the Remote Administrator, a 
message appears prompting you to register a License Server computer 
within the Remote Administrator.

Figure 62.  Register a License Server Computer? 

2. You have the following choices:

• To close the message box, but leave the empty Administrator window 
open, click No.

• To begin registering computers, click Yes. For more information and 
detailed instructions on registering License Server computers, see 
“Registering a Computer for Remote Administration” on page 78.

■ Registering a Computer for Remote 
Administration

You can administer License Server both from the computer on which License 
Server is installed and from remote computers. You can use the Administrator 
function that comes with a full installation of License Server to administer other 
License Server computers, or you can use the Remote Administrator, which 



Registering a Computer for Remote Administration

ASM License Server System Guide 79
StorageTek Proprietary

simply provides you with the Administrator interface and the registration 
capability to attach remotely to any networked License Server computer. 

The remote administration function is the same whether you use a License 
Server Administrator (full installation) or a Remote Administrator. Regardless 
of which Administrator function you have installed, you have to register the 
remote License Server computer in order to allow the Administrator you are 
running to find and connect to the remote License Server computer.

You can register License Server computers either using the auto-detect 
function or by adding the License Server computer manually by browsing to it. 
For more information, see the following sections:

• "Registering Computers Using Auto-Detect, " which follows

• “Registering Computers Manually” on page 81

Registering Computers Using Auto-Detect
For large systems with several License Server computers, the manual 
registration process becomes unwieldy since you must browse and select 
each computer on the network. The Auto-Detect Wizard allows you to detect 
and select all currently running License Server services on the network 
without browsing the system to find individual License Server computers.

The Auto-Detect function works as a wizard that leads you through the 
registration process.

To register License Server computers using the Auto-Detect Wizard:

1. From the Service menu in the Administrator in which you want to register 
the computer(s), select Register, or click the Register Computer toolbar 
button.

Figure 63.  Register Computer Toolbar Button 

The Register Computers dialog box appears.

Figure 64.  Register Computers Dialog Box 



Remotely Administering License Server

80 Second Edition
StorageTek Proprietary

All computers already registered with the currently open Administrator 
appear in the Register Computers dialog box. If you are registering 
through a Remote Administrator and you have not yet registered any 
License Server computers, the Register Computers dialog box is blank.

2. Click Detect to start the Auto-Detect Wizard. The Introduction page 
appears.

3. Read the Introduction and click Next. The Computer List page appears.

Figure 65.  Computer List Page 

The Auto-Detect Wizard detects all computers on which License Server is 
installed and where the License Server service is actively running

Note: The Auto-Detect Wizard does not detect License Server computers 
that have been powered off or where the License Server service 
has been stopped. 

4. Select the computer(s) you want to register and click Next.

Note: If a computer that you want to register does not appear in the 
Computers Detected list, you have to register the computer 
manually. For more information, see "Registering Computers 
Manually, " which follows.

The Summary page appears. The Summary page lists the selected 
computers.

5. Review the summary to make sure the computers you want to register are 
listed. 

6. If the information in the summary is correct, click Finish. The selected 
computers are registered and appear in the Register Computers dialog 
box.
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7. If you inadvertently list a computer you do not want to register, or you wish 
to delete a previously registered computer, select that computer and click 
Delete. Then click Yes on the confirmation message that appears.

8. Once the computers you want to remotely administer appear in the 
Register Computers dialog box, click Close. The Administrator attempts to 
connect to all registered License Server computers. All registered 
computer name(s) appear in the Computer drop-down list located directly 
beneath the menu bar in the Administrator, and in the tree view of the 
Administrator window.

The Administrator can be used to manage the License Server service on all 
registered and connected License Server computers. You can switch between 
registered computers by selecting different computer names from the 
Computer drop-down list or by selecting the computers in the tree view of the 
Administrator.

Registering Computers Manually
If the Auto-Detect Wizard does not detect a License Server computer you 
want to remotely administer, or if you want to select the computers yourself, 
you can register them manually.

To manually register a License Server computer:

1. From the Service menu in the Administrator in which you want to register 
the computer(s), select Register, or click the Register Computer toolbar 
button.

Figure 66.  Register Computer Toolbar Button 

The Register Computers dialog box appears.

Figure 67.  Register Computers Dialog Box 
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All computers already registered with the currently open Administrator 
appear in the Register Computers dialog box. If you are registering 
through a Remote Administrator and you have not yet registered any 
License Server computers, the Register Computers dialog box is blank.

2. Click Add. The Select Computer dialog box appears.

Figure 68.  Select Computer Dialog Box 

The Select Computer dialog box contains a list of machines on the current 
network. License Server must be installed on the remote computer before 
it can be registered for remote administration. 

3. Select the License Server computer you want to register and click OK, or 
double-click the computer. The Register Computer dialog box appears, 
listing the selected computer. 

4. Repeat steps 2 and 3 for each computer you want to register.

5. If you inadvertently list a computer you do not want to use as a License 
Server service, or you wish to delete a previously registered computer, 
select that computer and click Delete. The computer is removed from the 
list.

6. Once the appropriate computers appear in the Register Computers dialog 
box, click Close. The Administrator attempts to connect to all registered 
License Server computers. All registered computer name(s) appear in the 
Computer drop-down list located directly beneath the menu bar in the 
Administrator, and in the tree view.

The Administrator can be used to manage the License Server service on all 
registered and connected License Server computer(s). You can switch 
between registered computers by selecting different computer names from the 
Computer drop-down list or by selecting the computers in the tree view of the 
Administrator.
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■ Connecting to License Server Computers
When the Administrator is opened, it attempts to connect to all registered 
License Server computers (including the local computer for full installations of 
License Server). Once these connections have been made, the window 
displays information pertaining to each License Server service. 

The Administrator allows you to switch easily between registered License 
Server computers by selecting the computers in the tree view, or by selecting 
different computers from the Computer drop-down list.

Figure 69.  Computer Drop-Down List on the Toolbar 

Remember, to successfully connect to a License Server computer, you must 
have administrator rights on the selected License Server computer.

Disconnecting from a License Server Computer
You may wish to disconnect from the currently active License Server 
computer. Disconnecting from the active service removes that computer’s 
License Server components from the tree view, although the computer still 
appears, listed with a status of (Disconnected).

To disconnect from the active License Server computer:

1. From the tree view of the Administrator, select the computer from which 
you want to disconnect.

2. From the Service menu, select Disconnect, or click the Disconnect toolbar 
button.

Figure 70.  Disconnect Toolbar Button 

License Server removes the selected computer’s components from the 
tree view, and the computer is listed with a status of (Disconnected).

Reconnecting to a License Server Computer
Disconnected License Server computers appear in the tree view of the 
Administrator with a status of (Disconnected). Reconnecting License Server 
computers re-displays their registered licenses and configured license groups 
so that you can administer them.
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To reconnect to a License Server computer:

1. In the tree view of the Administrator, select the computer to which you 
want to connect.

2. From the Service menu, select Connect, or click the Connect toolbar 
button.

Figure 71.  Connect Toolbar Button 

License Server connects to the selected computer and the computer’s 
License Server components appear in the tree view of the Administrator so 
that you can administer them.
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AUsing RtfPad

Reports and event logs all appear in RtfPad. You can use RtfPad to save, 
print, and email logs, reports, and Event Viewer snapshots. You can also 
configure RtfPad to display event logs in a black-and-white interface, or with 
color to contrast errors and warnings from other events. When you encounter 
system errors, RtfPad allows you to easily find and view descriptions of the 
errors. For more information, see the following:

• "Saving in RtfPad, " which follows

• “Printing in RtfPad” on page 85

• “Previewing and Printing in RtfPad” on page 86

• “Setting up Printing in RtfPad” on page 87

• “Sending from RtfPad” on page 88

• “Changing the Error Format” on page 89

• “Using RtfPad Error Lookup” on page 90

■ Saving in RtfPad
You can save a log, report, or Event Viewer snapshot for future reference.

To save in RtfPad:

1. From RtfPad’s File menu, select Save As. The Save As dialog box 
appears. 

2. Navigate to the location where you want to save the file.

3. In the File name text box, specify a file name.

4. From the Save as type drop-down list, select the file format in which you 
want to save the file.

5. Click Save.

■ Printing in RtfPad
You can print a log, report, or Event Viewer snapshot for future reference.
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To print in RtfPad:

1. From the File menu, select Print, or press <CTRL>+P. The standard 
Windows Print dialog box appears.

Figure 72.  Print Dialog Box 

2. From the Name list, select the printer you want to use.

3. In the Number of copies text box, specify the number of copies you want to 
print. 

4. Make any other print setting selections and then click OK. The file is sent 
to the selected printer. 

■ Previewing and Printing in RtfPad
You can print a log, report, or Event Viewer snapshot for future reference, and 
you can preview it before printing.
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To preview and print in RtfPad:

1. From the File menu, select Print Preview. The text is displayed as it would 
appear when printed.

Figure 73.  Print Preview in RtfPad 

2. You have the following choices:

• To navigate to the next or previous page, click Next Page or Prev 
Page.

• To display two pages at a time, click Two Pages.

• To display one page at a time, click One Page.

• To zoom in on or zoom out, click Zoom In or Zoom Out. 

• To close the print preview without printing, click Close.

3. When you are ready to print the text, click Print.

■ Setting up Printing in RtfPad
You can configure how a log, report, or Event Viewer snapshot is printed from 
RtfPad.
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To set up printing in RtfPad:

1. From the File menu, select Print Setup. The Print Setup dialog box 
appears.

Figure 74.  Print Setup Dialog Box 

2. From the Name list, select the printer that you want to use as the default 
printer. 

3. Select the default paper size, source, and orientation. 

4. Make any other print setting selections and then click OK. 

■ Sending from RtfPad
You can send a log, report, or Event Viewer snapshot to someone by email.

To send an RtfPad file as an email attachment:

1. From the File menu, select Send. A mail dialog box corresponding to your 
email system appears. 
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Figure 75.  E-Mail Message with an RtfPad File as an Attachment 

2. Address the message to the desired user. 

3. Complete the message by adding any other comments.

4. Send the message using your email program’s Send command. 

■ Changing the Error Format
RtfPad can be viewed in a black-and-white interface, or with color to contrast 
errors and warnings from other events. If RtfPad is set for Error Format, text 
appears as described in the following table:

To set RtfPad to display information in error format:

• From the RtfPad View menu, select Error Format. This is a toggle 
command. When enabled (selected), a check mark appears to the left of 
the command.

To disable error format:

• From the RtfPad View menu, select Error Format again. This is a toggle 
command. When disabled, no check mark appears to the left of the 
command.

Table 11.  RtfPad Error Format Colors

Text Color
Errors Red

Warnings Yellow

Header Green

All other text Black
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■ Using RtfPad Error Lookup
When an error appears in RtfPad, an error number appears in brackets with 
the error message. This error number identifies the error and allows you to 
use the RtfPad error lookup feature to obtain additional information about the 
error, including the error name and a brief description. 

To obtain additional information about an error:

1. With the error log open, select the error number.

2. From the View menu, select Error Lookup, or press <F2>. The System 
Error Lookup dialog box appears with the error name and description. 

Figure 76.  System Error Lookup Dialog Box 

3. You have the following choices:

• To scroll through the list of system errors, click the forward or backward 
arrows. 

• To access context-sensitive help for the error glossary, click Help.

• To close the System Error Lookup dialog box, click Close.
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BUninstalling License Server 
Components 

When License Server is removed, all configuration settings and system files 
are deleted. If you reinstall License Server, new settings must be configured. 
Caution should be taken when removing the product, as all settings are 
permanently lost.

The License Server Setup Wizard, accessed through the License Server 
program group in the Windows Start menu, takes you step-by-step through the 
uninstall process.

Note: If you plan to reinstall License Server later, you should create a copy of 
your License Server configuration before you uninstall License Server. 
The Repair Disk Wizard allows you to back up your License Server 
settings. For instructions, see “Copying the Repair Disk Backup” on 
page 67.

For more information, see the following sections:

• "Uninstalling License Server, " which follows

• “Uninstalling the Remote Administrator” on page 92

■ Uninstalling License Server
The same License Server Setup Wizard that installed the program can be 
used to uninstall the program. 

Note: If you are removing License Server from a clustered environment, you 
should run the setup wizard to remove the product directly on the 
Primary server (the server node currently in control). 

To remove License Server:

1. From the Windows Start menu, select Programs,  License Server, and 
then Setup. The License Server Setup Wizard appears, starting with a 
welcome page.

2. Click Next. The Installation Options page appears.
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Figure 77.  License Server Removal -- Installation Options Page 

3. Select Remove product and related items and then click Next. A warning 
appears informing you that uninstalling cannot be undone.

Figure 78.  Uninstall Warning Message 

4. Click Yes to continue. The summary page appears.

5. Review the information in the summary.

6. If the information in the summary is correct, click Finish. A progress bar 
appears, indicating the completion percentage of the removal process. 

Any settings related to License Server in the Windows registry, all program 
files in the installation path, and the License Server program group/folder 
are removed. When the uninstall is complete, a message appears, 
indicating that License Server has been successfully removed. 

7. Click Restart. The computer is restarted and any remaining files from 
License Server are removed. 

■ Uninstalling the Remote Administrator
The License Server Remote Administrator can be removed from a computer if 
necessary. Removing the Administrator from a remote computer does not 
affect the License Server computer to which it points. Only the system files for 
the Remote Administrator are deleted. 

The same Remote Administrator Setup Wizard that installed the program can 
be used to uninstall the program. Because the setup wizard allows you 
uninstall the Remote Administrator from multiple computers at once, you may 
want to determine which computers are to have the Administrator removed 
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from them before you run the setup wizard, enabling you to run the wizard 
once rather than multiple times.

Note: If you are removing the Remote Administrator from a clustered 
environment, you should run the setup wizard to remove the product 
directly on the Primary server (the server node currently in control).

To remove the License Server Remote Administrator:

1. From the Windows Start menu, select Programs,  License Server, and 
then Setup. The Remote Administrator Setup Wizard opens, starting with 
the welcome page.

2. Click Next. The Installation Options page appears.

Figure 79.  Remote Administrator Removal – Installation Options Page 

3. Select Remove product and related items and then click Next. A warning 
appears informing you that uninstall cannot be undone.

Figure 80.  Uninstall Warning Message 

4. Click Yes to continue. The Target Computers page appears, with the local 
computer in the Target Computers list.
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Figure 81.  Remote Administrator Removal -- Target Computers Page 

Note: If you are removing the Remote Administrator from a clustered 
environment, select the logical cluster name as the target computer 
for removal.

5. You have the following choices:

• To remove the Remote Administrator from only the computer(s) listed 
in the Target Computers list, click Next. The Summary page appears.

• To remove the Remote Administrator from other computers in addition 
to the one(s) listed in the Target Computers list, click Add. The Browse 
Computers dialog box appears.

6. In the Browse Computers dialog box you have two choices:

• Under Available Computers, navigate to and select the computer from 
which you want to remove the Remote Administrator and then click 
Add to add the computer to the Selected Computers list. 

• In the Computer Name text box, type in the name or the IP address of 
the computer from which you want to remove the Remote 
Administrator and then click Add to add the computer to the Selected 
Computers list. 

Repeat this step for each additional computer from which you want to 
remove the Remote Administrator. When you finish, click OK. You are 
returned to the Target Computers page. When the Target Computers list is 
complete, click Next. The summary page appears.

7. Review the information in the summary.

8. Click Finish to complete the uninstall. A progress bar appears indicating 
the completion percentage of the removal process. 

9. If the information in the summary is complete, click Finish. A progress bar 
appears indicating the completion percentage of the removal process. If 
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you are uninstalling from multiple computers, separate progress bars 
appear for each computer.

Any settings related to the Remote Administrator in the Windows registry, 
all program files in the installation path, and the License Server Remote 
Administrator program group/folder are removed. 

Then, one of the following occurs:

• If you are uninstalling from a remote computer, the License Server 
Administrator Setup Result dialog box appears, listing the results for 
each target computer. Take note of any computers that need to be 
rebooted (or computers on which the uninstall failed) and then click 
OK. Restart each computer for which the License Server Administrator 
Setup Result dialog box indicates a reboot is required. 

• If you are uninstalling from the local machine, a message appears to 
prompt you to reboot the computer. Click Restart to close the message 
and reboot the computer immediately, or Exit to close the message 
without rebooting.
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diagnostic utilities, 39
disabling event logging, 46
disaster recovery, 65, 68
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disconnecting from remote computers, 83

E
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editing

license group names, 32
license group types, 33
license groups, 32
license type allocation for groups, 33
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errors

configuring format in RtfPad, 89
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log, 43
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logs, 43
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event log, 43
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ASM/DMS, 24
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License Server
configuration backup, 65
configuration restoration, 69

license types
adding to license groups, 30
deleting from license groups, 37

licenses
groups, 29
managing, 17
monitoring usage, 26
registering license file, 18
registering license key, 20
report, 53
viewing information, 22

Licensing Group Information report, 53
Licensing Information report, 53
log off users, 26

from license groups, 35
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event viewer, 43
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print setup in RtfPad, 87
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navigating in the Administrator, 9
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License Server configuration, 69
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registering
computers, 78
computers manually, 81
computers using Auto-Detect, 79
license file, 18
license key, 20

registry
backup, 65
backup location, 66
backup, copying, 67
restoring License Server configuration,

69
Remote Administrator

Computer drop-down list, 12
connecting to computers, 83
disconnecting from computers, 83
installing, 74
overview, 73
registering computers, 78
removing, 92
security and access, 74
starting for the first time, 78

removing
license groups, 38
License Server, 91
licenses from groups, 37
Remote Administrator, 92

renaming report layouts, 61
repair disk, 65
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restoring License Server configuration,

69
setting backup location, 66

Report Generator Wizard, 53
report layouts, 56

changing header and footer, 57
creating, 57
deleting, 63
editing styles, 59
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switching between, 62

reports, 71
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layout editor, 56
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License Server, 65, 68, 69
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setting up printing, 87
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uninstalling License Server, 91
uninstalling Remote Administrator, 92
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status bar, 14
styles for reports, defining, 56
system

backup and recovery, 65
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configuring, 39
error lookup, 46
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performance, impact of logs, 45, 46
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License Server, 43
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Windows
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New License, 18
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